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Introduction

The ScanWizard Industry scanning software is specifically designed for the 
use of the industry film scanning. This reference manual covers the various 
commands and features found in the ScanWizard Industry scanning software 
for the Windows system. The reference information is divided into three major 
sections, corresponding to the three major windows of the program: 

•	 Preview

•	 Settings

•	 Scan Job Queue

The ScanWizard Industry functions do not apply to all scanner models. See the 
table below to determine which function can be used for your scanner model.

	 MII-800XL Plus	 MII-900 Plus	 NDT-2000

Preview window	 V	 V	 V
Menus 
     Scanner menu	 V	 V	 V 
     View menu	 V	 V	 V 
     Correction menu	 V	 V	 – 
     Help menu	 V	 V	 V
Buttons & tools 
     Overview button 	 V	 V	 V 
     Prescan button	 V	 –	 – 
     Scan button 	 V	 V	 V
     Frame tool	 V	 V	 V 
     Magnify Glass tool	 V	 V	 V 
     Pane tool	 V	 V	 V
     Transform button 	 V	 V	 V
     Scan Process tool 	  
     • General	 V	 V	 V 
     • Auto Film Feeder	 –	 V	 V 
     • Multi-Channel Crop	 –	 V	 V 
     • Multi-Job Crop	 V	 –	 – 
     • Atuo Scan	 –	 V	 V
     Scan Mode button 	 –	 –	 V

Settings window	 V	 V	 V

Scan Job Queue window	 V 	 –	 –

( V: Supported; –: Not supported)
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The ScanWizard Industry Interface

ScanWizard Industry consists of three major windows: Preview, Settings, and 
Scan Job Queue.

The Preview and Settings windows appear automatically after the ScanWizard 
Industry is started up. The Scan Job Queue window appears when you bring up 
ScanWizard Industry at the first time. You may hide or show it from the View 
menu and click on the command Hide/Show Scan Job Window.

Settings window 
contains scanning 

parameters for 
the outputting 

image 

Scan Job
window

provides key
functions in

managing
scan jobs

Preview window 
has commands and tools for 
controlling the scanner
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Launching ScanWizard Industry

ScanWizard Industry can be launched in either Stand-alone or Plug-in mode.

•	 From Stand-alone mode: Double-click the ScanWizard Industry icon on 
the desktop, or choose Start, Programs, Microtek ScanWizard Industry for 
Windows, and then Microtek ScanWizard Industry.

•	 From Plug-in mode: Choose the Import or Acquire command from the File 
menu of your image-editing software, then select Microtek ScanWizard 
Industry.

After being launched, the main screen will appear, but the very first time that 
ScanWizard Industry is started up, the three windows will all appear. 

The next time you start up ScanWizard Industry, the main screen will look 
exactly like the last time you exited the software. This means that if you had all 
three windows open the last time you quit ScanWizard Industry, the same three 
windows will appear the next time you start it up. 

Exiting ScanWizard Industry

To exit ScanWizard Industry, double click on the close box on the upper left side 
of the Preview window. 

Click here to exit 
ScanWizard Industry
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The Preview Window

The Preview window is the prominent window and includes the various 
commands and tools for controlling the scanner. These commands and tools 
available in the Preview window will vary upon the scanner models .

Elements of the Preview Window  
(For MII-800XL Plus)

A. Menu bar

B. Overview  
button

C. Prescan  
button

D. Toolbar

E. Scan  
button

H. Preview area

J. Rulers

K. Unit of 
measurement

I. Status bar

G. Scan Process 
Tool button

L. Minimize button

F. Transform button

M. Exit button
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Elements of the Preview Window  
(For MII-900 Plus)

A. Menu bar

B. Overview  
button

D. Toolbar

E. Scan  
button

F. Transform button

H. Preview area

K. Unit of 
measurement

G. Scan Process 
Tool button

L. Minimize  
button
M. Exit button

I. Status bar

J. Rulers
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Elements of the Preview Window  
(For NDT-2000)

A. Menu bar

B. Overview  
button

D. Toolbar

E. Scan  
button

F. Transform button

H. Preview area

K. Unit of 
measurement

G. Scan Process 
Tool button

L. Minimize  
button
M. Exit button

I. Status bar

J. Rulers

N. Scan Mode 
button
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A.	 Menu bar: This area includes the different menus for setting up the scanner 
(Scanner menu), controlling view options (View menu),  Image Correction 
function (Correction menu), and accessing on-line help (Help menu). 

B.	 Overview button: This button previews the specified or entire scan bed.

C.	 Prescan button: This button previews one or more detailed images of the 
area(s) selected by the Scan Frame tool.

D.	 Toolbar: The buttons in the Toolbar perform specific actions on the 
Overview or Prescan image. The Toolbar includes the Frame (Scan Frame) 
tool, Magnify Glass (Zoom)  tool,  and Pane (Move) tool.

E.	 Scan button: This button starts the final scanning process.

F.	 Transform button: This button lets you flip the image horizontally or rotate 
the image vertically.

G.	 Scan Process Tool button: This button lets you activate some scanner 
functions, such as Auto Film Feeder, Multi-Job Crop and Multi-Channel 
Crop, which are supported by specific scanner models.

H.	 Preview area: This area in the Preview window shows the Overview or 
Prescan image.

I.	 Status bar: The area shows you some information for easier operation. 

J. 	 Ruler: Rulers are located on both sides of the Preview window to help you 
with measurement and alignment.

K.	 Unit of Measurement: Select the unit of measurement for the rulers and the 
ruler colors by clicking the arrow at the 0,0 point of the rulers and choosing 
from the drop-down menu.

L. 	 Minimize button: Click the Minimize button to minimize ScanWizard 
Industry.

M.	 Exit button: Click the Exit button to close ScanWizard Industry scanning 
software.

N.	 Scan Mode: This button is used to switch between the Standard mode and 
the Speed  mode.
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Preview Area

The preview area is where the overview or prescan image appears after you click 
the Overview, Prescan, or Scan button. 

The dimensions of preview area depend on the sizes supported by the scanner. 
For example, if your scanner only supports a maximum size of 12” x 16”, the 
maximum preview area will be limited under this limitation.  

To increase or decrease the 
preview window, drag the 
window to resize
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However, for some scanner models (ex. MII-900 Plus, NDT-2000), you are 
allowed to resize the preview area as you wish.  

For example, the MII-900 Plus offers you two kinds of dimensions of preview 
area, which are 14" x 17" (default) and 14" x 200" (maximum), depending on 
which one you select in the Scan Frame settings.  You can use the maximum 
size instead of the default size for the preview area by entering a value greater 
than 17, for example, 20,  in the Height (H) edit box of the Scan Frame settings. 
Then, press the Overview button to perform a preview of the image. Thereafter, 
the preview area will be resized to the maximum size of 14" x 200" at once.

Default size of preview area Maximum size of preview area

Please take note that you cannot use the Scan Frame settings to resize the 
preview area given by using the Scan Frame tool.  Also, if the after-scanned 
image size is more than 2 GB, the system will pop up a reminding message 
which notifies that the final image size is too big to be carried out; therefore, you 
have to decrease the resolution under 600 dpi.

For MII-900 Plus, enter a value 
greater than 17 to expand the preview 
area up to maximum size of 14" x 
200" if needed; enter a value less 
than 17 to reverse the value back to 
the default size. 
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Prescan viewing mode

Overview, Prescan

Overview

The Overview button previews the image on the scan bed . By default, the entire 
scan bed is previewed when you click the Overview button.

Prescan

The Prescan button previews in high resolution the area selected by the Scan 
Frame tool. Multiple prescans can be done if you have several selected scan jobs, 
and the prescans are done one after another in the order that they are listed in 
the Scan Job Queue window. 

Note: Not all scanner models support this feature. If your scanner model is not 
supported, the Prescan button will not be shown in the Preview window.  

To obtain the prescan image:

1. 	 Click the Scan Frame tool.

2.	 Select the area to be prescanned by drawing a frame around the area in the 
Overview image.

3.	 Click the Prescan button. The Prescan image will then be available for 
viewing in the View menu, and a thumbnail of the image will appear in the 
Scan Job Queue window.
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Overview viewing mode

Prescan viewing mode

To obtain multiple prescan images:

1.	 Define your scan jobs in the Scan Job Queue window (see the Scan Job 
Queue window section for more details).

2.	 To select multiple scan jobs, press the Ctrl  key and click on the jobs to be 
selected in the Scan Job Queue or Preview window.

3.	 Click the Prescan button. Multiple prescans are created in the process, 
corresponding to the number of scan jobs defined. You can then switch 
among the various prescan images for viewing.
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Scan

The Scan button scans the images on your scanner and delivers the images to 
your selected folder or application. The images that are scanned are the scan 
jobs that have been checked in the Scan Job Queue window.  This is the default 
button when ScanWizard Industry is launched either as a stand-alone or from an 
application program.

When the “Scan To: Save As” dialog box appears, key in a file name, then select 
TIFF, J2K, JPG or DTI as the export file format, and  click Save to perform the 
final scan. 

Note: DTI format can be activated only when the Scan Type in the Settings window  
is set as Gray Scale (16-bit).  Also, it can be opened only in MiiNDT software and 
supported by specific digitizer models.

File name

This is the file name to store images.

Save as type

This menu box lets you select a file format when saving a file. If TIF is selected, 
the scanned images will be automatically identified as “Image00001.tif”, 
“Image00002.tif”, etc. You can change the default root file name to uniquely 
label your scan jobs.

Auto filename

If Auto filename is checked, the file name consists of the file prefix, plus the file 
serial number. If unchecked, no file serial number is appended to the file name.
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•	 File prefix: This edit box lets you enter a root file name. “Image” is the 
default. 

•	 Start file #: This edit box lets you enter a starting number to be appended to 
the file name. “00001” is the default.

Send image to application after saving:  

If this option is checked, the scanned images are sent to your selected 
application.

File Option

The File Option button is a file compression tool, allowing you to save your 
scanned image with different image quality. This button is activated only when 
the file format is set as TIFF or JPG; otherwise it will not be shown. 

•	 If “TIF” is selected, a “TIFF Save Options” window will appear after clicking 
the File Option button. Specify your requirements for your file as your 
desired. If you choose “None” in the Encoding option, the file compression 
will not be available for adjusting. 

•	 If “JPG is selected, a “JPG Save Options” window will appear after clicking 
the File Option button. 
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Rulers, Unit of Measurement

The rulers on the top and left sides of the Preview window help you with 
measurement and alignment, marking off measurement according to the selected 
unit.

The unit of measurement can be selected from the Unit box in the Settings 
window. The options for unit of measurement include inch, centimeter, and 
millimeter. 

Ruler
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Transform

The Transform function allows you to rotate and / or flip the image.

The effects of the Transform function will be seen in the Prescan image or are 
after you click the Scan button and scan the image in; the Transform effect is not 
shown in the Overview viewing mode.

To use the Transform function:

1.	 Click the Transform button in the Preview window.

2.	 From the options that appear, choose the degree of rotation you wish.

3.	 Click the Scan button in the Preview window. When the image is scanned, 
it will be rotated or transformed according to the selected option.
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Scan Process Tool

Scan Process Tool lets you perform some functions 
which can be activated only by some scanner models 
with unique devices attached. These functions include 
General, Auto Film Feeder, Multi-Channel Crop, Multi-
Job Crop, and Auto Scan.

General

General Function is the default setting when 
ScanWizard Industry is activated. When this mode is 
on, the scanner will perform a final scan job based on 
your settings and then deliver the scanned image to 
your preferred folder or application.

Auto Film Feeder (AFF)

Auto Film Feeder Function can be activated only for scanner models that has 
installed the AFF already (e.g., MII-900 Plus, NDT-2000); otherwise it will be 
grayed out in the options menu. When this function is activated, the scanner is 
capable to scan multiple pieces of X-ray film through the Auto Film Feeder (AFF), 
to save the scanned image in a file, and to deliver them to your preferred folder 
or application.

To access this function, click and hold the Scan Process Tool until the options 
menu under the button appears. Then, directly select “Auto Film Feeder” from 
the option menus. The icon of Scan Process Tool will become the icon of Auto 
Film Feeder once the function is selected.

Multi-Channel Crop

Multi-Channel Crop Function can be activated only for scanner models that 
support multi-channel feed tray scanning (e.g., MII-900 Plus, NDT-2000); 
otherwise it will be grayed out in the options menu. When this function is 
activated, the scanner is capable to scan three pieces of X-ray film at the size of 
12.01" x 3.15" (30.5 x 8 cm) for one time by the help of an exclusively-designed 
film feed tray, to save the scanned image in a file, and to deliver them to your 
preferred folder or application.

To access this function, click and hold the Scan Process Tool until the options 
menu under the button appears. Then, directly select “Multi-Channel Crop” 
from the option menus. The icon of Scan Process Tool will become the icon of 
Multi-Channel Crop once the function is selected.
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Multi-Job Crop

Multi-Job Crop Function can be activated only for scanner models that support 
multiple scan frames scanning (e.g., MII-800XL Plus); otherwise it will be grayed 
out in the options menu. When this function is activated, the scanner is capable 
to scan multiple pieces of X-ray film at one unified setting at one time, to save 
the scanned images one by one separately, and to deliver them to your preferred 
folder or application.

To access this function, click and hold the Scan Process Tool until the option 
menus under the button appears. Then, directly select “Multi-Job Crop” from the 
option menus. The icon of Scan Process Tool will become the icon of Multi-Job 
Crop once the function is selected.

Please take note that when the Multi-Job Crop function is activated, there is 
only one set of scan settings adopted by all jobs at one time. Therefore, if you 
have made any change of scan settings for a job before performing the final scan, 
these changes will apply to all jobs for the final scan.

Auto Scan

Auto Scan function can be activated only for scanner models that is equipped 
with film detector (e.g., MII-900 Plus, NDT-2000) ; otherwise it will be grayed 
out in the options menu. When this function is activated, the scanner will detect 
automatically whether there is film on the input tray (e.g., standard feed tray 
or multi-channel tray) by a sensor. When film is detected, the scanner will start 
scanning automatically.

To access this function, click and hold the Scan Process Tool until the option 
menus under the button appears. Then, directly select “Auto Scan” from the 
option menus. 
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Scan Mode 

The Scan Mode contains two modes: Standard Mode and Speed Mode.  You can 
select either one of two modes to scan a film based on the requirements. 

Note: Not all scanner models support this feature. If your scanner model does not 
support this feature, the Scan Mode button will not be shown in the Preview window.

Standard Mode

The Standard Mode is an image capturing method which meets with the BAM 
standard, converting the density of a 16-bit positive film image into a negative 
film image by multiplying 10,000. When saved as a TIFF format, it can be 
displayed as a positive film image again. This mode is suitable for the film with 
high density but in needs of superior image quality.  However, the scanning 
speed will be slowed down.

Speed Mode

The Speed Mode is the default setting, which can improve the contrast ration of 
a normal image. 
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The Toolbar 

The buttons in the Toolbar perform specific actions on the Overview or Prescan 
image. The Toolbar includes the Frame (Scan Frame) tool, Magnify Glass (Zoom)  
tool,  and Pane (Move) tool.

Scan Frame (Frame) Tool

The Scan Frame tool lets you select the area to be scanned or prescanned. You 
can have multiple scan frames, but only one scan frame can be current at a time; 
the current scan frame is indicated by a flashing marquee. 

To use the Frame tool:

1.	 Click the Frame tool. 

2.	 Move the pointer (now a crossbar) to the Overview image, and draw a frame 
enclosing the area to be selected. When you release the mouse, a flashing 
marquee will indicate the scan frame. To create multiple scan frames, hold 
down the Shift key and drag your next scan frame.

3.	 To resize the scan frame, drag a corner of the scan frame and resize to the 
desired area.

4.	 To change the position of the scan frame, drag inside the scan frame and 
move to a new location.
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Magnify Glass (Zoom) Tool

The Magnify Glass tool lets you zoom in (magnify) and zoom out (reduce) your 
view of the image. Only your view of the preview image is changed; the actual 
size of the image remains unaffected.

Each click of the Magnify Glass tool magnifies or reduces by a factor of 2. Thus, 
the magnification levels increase from 100% to 200%, to 400%, and to the 
maximum 800%.

To magnify (reduce), hold down the Shift key and with the Magnify Glass tool 
selected, click the image. A minus sign will be in the middle of the lens to 
indicate the image is being zoomed out.

To use the Magnify Glass tool:

1.	 Click the Magnify Glass tool.

2.	 Place the pointer — now a lens with a plus sign inside it — on the image 
and click. To reduce the view, hold down the Shift key (the Magnify Glass 
tool changing to show a minus sign inside it), and click again. 

Magnify before Magnify after
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Pane (Move)  Tool

The Pane tool lets you scroll through an overview or prescan image, allowing 
you to move parts of the image into view quickly without using the scroll bars.

You can use the Pane tool for scrolling through zoomed-in images that were 
enlarged through the Magnify Glass tool, or for scrolling through parts of an 
image not included completely within the frame of the preview window.

To use the Pane tool:

1.	 Click the Pane tool.

2.	 Move the pointer (now in the form of a hand) to the image. Hold down the 
mouse and move the Pane tool left, right, up, or down, and you will see  
portions of the image come into view. 

Move before Move after
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The scanner is displayed with its USB 
or FireWire ID number. The current 
scanner is marked by a check.

The Scanner Menu

The Scanner Menu lets you:

•	 Show your scanner model or select a scanner if you have multiple scanners

•	 Get information about your scanner

•	 Get scanner information on the USB / FireWire chain

•	 Perform special scanner controls unique to the scanner (e.g. set idle time for 
saving power)

•	 Save the calibration time 

•	 Get a scan count

Scanner Model 

The scanner model (and its USB or FireWire ID number) is shown at the top of 
the scanner. If you have multiple scanners on your system, all the scanners are 
shown with their respective IDs, and the current scanner is indicated by a check.

Only one scanner can be accessed at a time. To switch among various scanners, 
select the scanner to be used.
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Get Current Scanner Info 

This command provides information about your current scanner. When you 
choose this command, a dialog box appears showing the scanner model, the 
scanner ID number, and the firmware version.

Scanner Probe 

This command shows the scanner information on your USB or FireWire chain. 
If your scanner does not show in the Scanner Probe dialog box, make sure your 
scanner is properly installed, connected, and turned on, and then click the Probe 
button. For details on connecting your scanner, refer to your scanner hardware 
installation guide.
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Scanner Control (Power Saving Control)

This command lets you use some of the special features of your scanner, such as 
lamp control.

Note: Not all scanner models support this feature. If your scanner model is not 
supported, the Scanner Control command will be grayed out in the Scanner menu. 

Lamp Control

This the power-saving feature of the scanner lamp to save energy and extend the 
life cycle of the lamp. By default, the lamp turns off automatically if the scanner 
is idle for 15 minutes. You can change the lamp idle time in your preferences 
or disable this feature completely by unchecking the Auto Power Saving Mode 
check box.

By default, the lamp warm-up time is 3 minutes. A lamp warm-up dialog box 
will appear if you try to perform a scan or preview operation without the lamp 
having fully warmed up. If the lamp is not fully warmed up, the light intensity 
of the scanner may not be stable and may adversely affect the quality of your 
scanned image.

The current lamp status is indicated. You may specifically turn the lamp on or off 
if you wish. Please note that the lamp On / Off state is automatically controlled 
by the software, and no user intervention is necessary. You may want to do 
this manually if and only if you wish to turn on and warm up the lamp a few 
minutes before you actually finish your scan job editing.
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Smart Calibration

This function allows you to skip the calibration when you perform the scans with 
a same value of resolutions.  For instance, if you wish to run all your scan jobs at 
200 dpi of the resolution, the system will only calibrate the scanner at first time.  
After the first scan is done, this calibration data will be memorized and kept 
for subsequent use.  Therefore, you do not need to calibrate your scanner every 
time when you press the Scan button.  Take note that the calibration data used 
for each resolution value will be erased once you exit ScanWizard Industry each 
time.  

Note: Not all scanner models support this feature. If your scanner model is not 
supported, the Smart Calibration command will be grayed out in the Scanner menu. 

Smart

This option enables you to perform the Smart Calibration function. By default, 
this option is checked automatically when you activate the Smart Calibration 
command.  

Typical

This option can be used instead of the “Smart” if you like to calibrate your 
scanner every time when scanning. 
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Export Count Data

Some scanner models can keep the trace of some scan data, such as scan count, 
scan date, scanner's series number, etc. Such a trace data is encrypted and can be 
saved in a SCI file format for output use. It is very useful in getting a scan data 
after the scanner is being used for a period of time.

This command is enabled only when the scanner model used supports this 
function (i.e., MII-800XL Plus); otherwise, it will be grayed out in the Scanner 
menu. 
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The View Menu

The View menu lets you:

•	 Select an overview or prescan view of an image

•	 Resize the Preview window to fit

• 	 Bring the Settings window to the front

•	 Show or hide the Optimization button in the Settings window

•	 Show or hide the Scan Job Queue window

•	 Show or hide Status Bar

Overview Image, Prescan Image

These commands allow you to switch between Overview or Prescan viewing 
modes.

•	 Overview image: This is an image obtained when you click the Overview 
button in the Preview window. The image shows you whatever is on your 
scan bed.

•	 Prescan image: This is a detailed image obtained from selecting an area in 
the Overview image and then clicking the Prescan button in the Preview 
window.

The Overview is a preview of your image. The maximum size of the Overview 
varies, depending on your scanner model. For example, if the scan bed (the 
glass surface) of your scanner has a maximum size of 12" x 16", the maximum 
Overview will be limited to those dimensions.
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Overview viewing mode Prescan viewing mode

A. To obtain the Overview image

With the image(s) placed on your scanner, click the Overview button.

B. To obtain the Prescan image:

1. 	 Click the Scan Frame (Frame) tool.

2.	 Select the area to be prescanned by drawing a frame around the area in the 
Overview image.

3.	 Click the Prescan button. The Prescan image will then be available for 
viewing in the View menu, and a thumbnail of the image will appear in the 
Scan Job Queue window.
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Resize before Resize after

C. To obtain multiple Prescan images:

1.	 Define your scan jobs in the Scan Job Queue window (see the Scan Job 
Queue window section of the manual for more details).

2.	 To select multiple scan jobs, press the Shift key and click the jobs to be 
selected in the Scan Job Queue or Preview window.

3.	 Click the Prescan button. Multiple prescans are created in the process, 
corresponding to the number of scan jobs defined. You can then switch 
among the various prescan images for viewing.

Resize Window to Fit

This command resizes the Preview window, which you may find helpful to do 
for conserving space on your desktop monitor (especially after you have enlarged 
the Preview window).

This command is available only when the current zoom level is set as 100%. It 
will be disabled if the zoom is set to other levels. 
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Bring Settings Window to Front

This command brings the Settings window to the forefront, which is useful if 
you have the Settings window hidden behind other windows or if you have a 
expanded your Preview window such that it covers the Settings window.

Show/Hide Commands

These commands allow you to switch between showing or hiding the Scan Job 
Queue window, the Optimization button in the Settings window and Status Bar 
on your screen. 

To use this feature, choose the correct command from the View menu for 
viewing a window. When the window appears, you can hide it by choosing the 
particular Hide command for it. 
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The Correction Menu

The Correction Menu lets you use the Advanced Image Correction (AIC) tools of 
ScanWizard Industry, allowing you to adjust and enhance the image, and image 
corrections are displayed in real time. 

Note: Not all scanner models support this feature. If your scanner model is not 
supported, the Correction Menu will not be shown in the Preview window.  

Elements of the Advanced Image Correction (AIC) Dialog Box

E. Preview option

A. Left  
thumbnail

B. Right thumbnail

J. Expansion 
button

H. Action 
Buttons

I. Advanced 
Image 

 Correction  
Tools

F. AIC pop-up 
menu

D. Hide Thumbnails 
button

G. Core of the 
AIC screen

C. 1:1 Thumbnail
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A.	 Left thumbnail: This shows the image before enhancements are applied.

B.	 Right thumbnail: This shows the image after enhancements are applied.

C.	 1:1 Thumbnail: If checked, size of the thumbnail is about the same as the 
image shown in the Preview window. If unchecked, the image size appears 
fit into the shown dialog box. 

D.	 Hide Thumbnails button: If checked, the before and after thumbnails are 
shown in the AIC screen. You can choose to uncheck this option and hide 
the thumbnails, since changes can be previewed in the Preview window. 
If unchecked, the screen collapses to show only the lower portion of the 
dialog box.

E.	 Preview option: If checked, changes or enhancements are applied 
immediately to the Preview window image (for both Overview and Prescan 
images). If unchecked, changes are seen only after you close the AIC dialog 
box.

F.	 AIC pop-up menu: This contains custom and other settings you have 
created for the particular AIC tool shown. See the Custom Settings section 
for more details.

G.	 Core of the AIC screen: This is the heart of the AIC screen, and the content 
here changes to reflect your selected AIC tool.

H.	 Action Buttons: These carry out a specific action. See the next section for 
more details.

I.	 Advanced Image Correction Tools (AIC): These tools adjust or enhance your 
images. Click any tool in this area, and see how the core of the AIC screen 
changes to reflect the properties of that tool.

J.	 Expansion button: The button reveals the top half of the AIC screen, which 
includes the various thumbnail controls.
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The Action Buttons 

The Action Buttons in the AIC dialog box let you accept, cancel, or control the 
application of AIC settings.

OK button

This button applies to the current scan job whatever image enhancements you 
have performed, and then closes the AIC dialog box.

Cancel button

This button cancels out all image-enhancement changes you have made to the 
current scan job, and then closes the AIC dialog box. The settings remained 
unchanged.

Default button

The button cancels the changes you have made with the image correction tools 
and restores all settings to their default values.

Revert button

This button cancels out the changes that were made with the current image 
enhancement tool. This means that if you used several AIC tools, Revert cancels 
the effect of only the last used (or current) tool, and preserves the effects of the 
other preceding tools.

Add to Menu button

This button allows you to save the changes you have made to the current scan 
job as a custom setting. You may retrieve this customized setting afterwards from 
the AIC pop-up menu.  Maximum 20 sets of customized settings for each AIC 
function.
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Custom Settings

When you click the AIC pop-up menu in AIC dialog box, a drop-down menu 
will show options for adding (Custom..), removing, or loading custom settings. 
These custom settings are settings that you define yourself for your scan jobs.

For instance, if you wish to apply a certain white point to an image and then 
save that white point setting for future jobs, you can add the new white setting 
as a custom setting. The next time you wish to retrieve that particular white 
point setting, simply go to the AIC pop-up menu, and choose that setting.

A.  Adding custom settings

The Add to Menu... allows you to save a 
custom setting you have made to the current 
scan job. You may retrieve this custom setting 
later from the AIC tool’s pop-up menu. 

To add a custom setting for an AIC tool, click 
the Add to Menu... button in AIC dialog 
box. When a dialog box comes up, enter the 
name of the new custom setting to be added. 
For instance, the added setting can be called 
“lightness2” as shown below.
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B.  Removing custom settings

The Remove Settings... allows you to remove 
a custom setting (or a factory preset setting) 
from the list of settings available. 

To remove a custom setting for an AIC tool, 
click the Remove Setting...in that tool’s AIC 
pop-up menu. When a dialog box comes up, 
select the particular setting to be removed, 
then click Remove in the dialog box.

C.  Loading / retrieving user-defined AIC settings

To load or retrieve a custom setting that you have previously defined for an AIC 
tool, go to that tool’s AIC pop-up menu, and choose the setting you wish to be 
loaded.



36          ScanWizard Industry Reference Manual

White/Black Points Tool

The White/Black Points tool is used to change the shadow and highlight points 
of an image. By using this tool, you can manipulate an image to either bring out 
the highlights in a very dark image, or bring out more of the shadows in a very 
light image. 

Click to bring up the 
White/Black points 
setup dialog box. 
For more details, 
see the next section 
“White/
Black Points Setup”.
 

Click to let 
ScanWizard 
Industry determine 
the shadow and 
highlight points 
automatically

Observe 
histogram values 
for distribution of 
the Lightness "L" 
channel in the 
image, as cursor 
is swept around 
histogram

Enter custom 
Lightness value 
for Highlight 
(White area) here

Enter custom 
Lightness value 
for Shadow (Black 
area) here 

Drag sliders to 
define custom 
shadow and 
highlight 
settings

Click to save the changes 
you have made to the 
current scan job as a 
custom setting 

Click to restore all 
settings to default 
ScanWizard Industry 
values 

Click to cancel out the 
changes that were 
made with the current 
image enhancement 
tool
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White/Black Points Setup

This button provides you with advanced controls for setting the clipping points 
for your white and black points, as well as determining the output levels for the 
white/black points on your printer.

To use this feature,  click the Setup button in the White/Black Points dialog box.  
When the dialog box comes up, specify your preferences.

A. Auto Clipping

The Auto White Point Clipping and Auto Black Point Clipping fields allow you 
to specify the percentage by which the white and black points, respectively, can 
be clipped from the histogram. The clipping is done after you click the Auto 
button in the AIC White/Black Points dialog box.

For example, if you specify 10 percent as your White Point clipping value and 
then click the Auto button, the white point on the histogram is adjusted so that 
10 percent of the color information is “clipped” or ignored. The resulting 90 
percent information leftover is then remapped, resulting in an image with less 
highlight detail.

The same principle above applies to the Auto Black Point Clipping feature, 
which governs the black point for shadows. These fields are normally used by 
more advanced users..
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B. Output Levels

The Minimum Output Level lets you set the minimum output level of the black 
point. The higher the percentage value, the lower the contrast will be.

The Maximum Output Level lets you set the output level of the white point. The 
lower the percentage value, the lower the contrast will be.
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Gradation Tool

The Gradation tool lets you adjust the midtones (the mid-level grays) of the 
lightness channel “L” of an image without altering the color itself. This is because 
even with changes to the luminance or lightness value, the chroma and hue 
values are kept constant. 

Modified curve

Original curve

How to read the curve

The curve shows the relationship of the 
brightness changes across the middle pixels 
between the resulting image and the original. 
When you open the Curves dialog box, the 
line on the graph is diagonal because the 
Input and Output values are the same. 

When the curve is moved up or down, the 
relationship between input value and output 
value changes accordingly.

•	 In areas where the curve is moved down, 
pixels in that portion of the image are 
darkened.

•	 In areas where the curve is moved up, 
pixels in that portion of the image are 
lightened.

Contrast in an image can be seen by the 
angle of the line. The steeper the slope, the 
higher the contrast. The closer the line is to 
horizontal, the lower the contrast.
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Choose the 
method you wish 
to display the 
gradation curve. 
Select from Curve, 
Line, or Gamma

Click Auto to 
let ScanWizard 
Industry 
calculate the 
Gradation setting 
automatically 

Coordinates 
information of 
cursor position 
within the grids

Click to create handles from which 
to drag and manipulate a portion 
of the curve. 
The more handles are created, 
the easier and smoother it is to 
manipulate the curve. 
To remove a handle, drag it off the 
graph or the grid

Dragging the 
top- right section 

of the curve 
below the default 
diagonal line will 

add shadow to 
light tones

Dragging the 
bottom-left 

section of the 
curve above the 
default diagonal 

line will add 
lightness to 

shadow tones

Click to save the changes 
you have made to the 
current scan job as a 
custom setting

Click to restore all 
settings to default 
ScanWizard Industry 
values 

Click to cancel out the 
changes that were 
made with the current 
image enhancement 
tool
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Appearance of curve if 
Method chosen is “Line”

Appearance of curve if 
Method chosen is “Gamma”

Instead of dragging the Gamma 
handle, you can also directly enter the 
appropriate Gamma value in the edit 
box. 

Dragging points on the curve to a Gamma 
value above 1.00, will lighten the dark 
tones. Dragging points on the curve to a 
Gamma value below 1.00 will add shadows 
to light tones

Dragging the lower left section 
of the line above the default 
diagonal line will add shadow to 
light tones

Dragging the upper right section of the 
line below the default diagonal line will 
add lightness to shadow tones
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Choose the 
filter you want 
from this area

Check this box to ensure that for the 
Unsharp Masking filter, the image 
displayed in the preview window simulates 
that of the final scan

Filter Tool 

The Filter tool is used to apply special effects to your images. Several filters are 
provided in ScanWizard Industry, including Blur / Blur More, Sharpen, Emboss, 
Edge Enhancement, Gaussian Blur, and Automatic Sharpness Enhancement.

In using most of the Filters (except Unsharp Masking), the image you obtain in 
the preview window may differ from the way the image appears when you finally 
scan it in. For the Unsharp Masking filter, the final scan result can be simulated 
and previewed, either from the thumbnail on the filters dialog box or from the 
preview image in the Preview window.

Keep in mind too that the appearance of the image in the preview window and 
how it is affected by a filter will depend on the resolution of the image. The 
higher the resolution, the less obvious the effect of certain filters (such as Blur).
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Click the center Weight edit box. This 
represents the pixel being evaluated. 
Enter the value by which you want to 
multiply that pixel’s brightness value. 
Value range is +/-99
Click a Weight edit box representing 
an adjacent pixel for you to assign a 
weighted value. Enter the value by 
which you want to multiply the pixel 
in that position multiplied. 
For example, if you want the 
brightness value of the pixel to the 
immediate bottom of the current pixel 
multiplied by 1, enter 1 in the Weight 
edit box right under the center 
Weight edit box.
Repeat the last two steps for all the 
pixels you want to include in the 
operation. It is not necessary to enter 
values in all the Weight edit boxes.

In the Scale edit box, enter the 
value by which to divide the sum of 
the brightness values of the pixels 
included in the operation.
In the Offset edit box, enter the value 
to be added to the result of the scale 
calculation.

Choose a filter mask size, 3x3 or 
5x5. Notice the Weight edit boxes 
switches between 5x5 (25) and 3x3 (9) 
edit boxes.

Enter a filename in the Filter edit box, and click the 
Add button to save current customized filter in the 
Filter drop-down menu. Click Remove button to 
delete custom setting from the Filter menu. 

A. Blur

The Blur filters eliminate noise in the parts of the image where significant color 
transitions occur. These filters decrease the contrast between adjacent pixels, 
making the image appear hazy and out of focus. 

•	 Blur smooths out the transitions by lightening pixels next to the hard edges 
of defined lines and shaded areas. 

•	 Blur More produces an effect three or four times stronger than Blur.

B. Custom

The Custom filter changes the brightness values of each pixel in the image 
according to a predefined algorithm known as convolution.  This filter allows 
you to define a 3x3 or 5x5 mask size custom filter (see dialog box next page for 
details).
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D. Emboss

The Emboss filter makes a selection appear raised or stamped by suppressing the 
color within the selection and then tracing its edges with black. 

E. Gaussian Blur

The Gaussian Blur is used to defocus an area of the image where significant color 
transitions occur or where noise exists, and the filter produces a hazy effect. 
“Gaussian” refers to the bell-shaped curve that is generated when this filter 
adjusts the color values of the affected pixels. The dialog box below appears 
when you choose Gaussian Blur from the Filters menu.

F. Sharpen (Unsharp Masking) 

The Sharpen filter adjusts the contrast of edge detail and creates the illusion of 
more image sharpness. This filter can be useful for refocusing an image that has 
become blurry from interpolation or scanning. The dialog box below appears 
when you choose Sharpen from the Filters menu.

Enter a value (1-10) in the Strength 
edit box (or drag the slider). 
This parameter specifies the degree 
of the filter’s effect. The higher the 
value, the stronger the blurring effect 
of the filter.

Select a mask size from the Mask 
Size list box. 
This parameter determines the depth 
of the surrounding pixels that will be 
affected. The larger the mask size, 
the stronger the blurring effect of the 
filter.

Enter a value (0-255) in the Threshold edit 
box (or drag the slider). 
This parameter allows you to specify a 
tolerance range or a field of contrast between 
adjacent pixels before blurring is applied. 
Blurring is applied only when pixel differences 
are below the Threshold value. The smaller the 
Threshold value, the weaker the blurring effect.
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C. Edge Enhancement

The Edge Enhancement filter gives greater contrast to edges. The filter can 
do this because edges are areas in an image where gray or color levels change 
abruptly. It is best to use this tool for improving geometrical contoured shapes. 

Enter a value (0-100) in the 
Strength edit box (or drag the 
slider) to specify the degree of 
the filter’s effect. 
The higher the value, the stronger 
the sharpening effect of the filter. 
Too much sharpen will emphasize 
the noise in the image.

Enter a value (0-255) in the Threshold edit box (or 
drag the slider).  
This parameter specifies a tolerance range to 
prevent overall sharpening that might generate 
noise or cause unexpected results.

The Threshold defines the required range 
of contrast between adjacent pixels before 
Sharpen is applied. Only the pixels with the 
range of contrast between adjacent pixels 
before sharpening is applied to an edge. A lower 
Threshold value produces a more pronounced 
effect.

Enter a value (0-60) in the Light edit box (or 
drag the slider). 
This parameter pertains to how the Sharpen 
filter affects pixels which are lighter than 
their adjacent pixels. By default, a value of 
60 is specified for this field. 
The higher the value, the lighter the edge 
around the darker areas and the more 
pronounced the Sharpen effect is.

Enter a value (0-100) in the Dark edit box (or 
drag the slider).
This parameter pertains to how the Sharpen 
filter affects pixels which are darker than 
their adjacent pixels. By default, a value of 
100 is specified for this field. 
The higher the value, the darker the edge 
around the lighter areas and the more 
pronounced the Unsharp Masking effect is.

Select a mask size from the Mask Size 
list box. 
This parameter determines the depth of 
surrounding pixels that will be affected. 
The larger the mask size, the stronger 
the sharpening effect of the filter.
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G. Automatic Sharpness Enhancement

The Automatic Sharpness Enhancement feature includes Sharpen Low, Sharpen 
Medium, and Sharpen High. This feature emphasizes the edges (contours) of an 
image, contributing to the increased sharpness.
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The Help Menu

The Help menu lets you access on-line help for ScanWizard Industry, and gives 
you information on the ScanWizard Industry scanning software.

Microtek Web Site

This command allows you to link to Microtek's website. You can download the 
driver from Microtek support site if it is necessary to be upgraded.

About

This command gives you information on the ScanWizard Industry scanning 
software. ScanWizard Industry is also referred to in the About screen as the 
ScanWizard Industry scanner controller.
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The Settings Window

The Settings window contains the parameters for outputting your scanned image 
for the current scan job and includes the image qualilty controls of the program. 
The controls available in the Settings window will vary upon the scanner models.

Elements of the Settings Window 

A. Scan Job

F. Unit of measurement

B. Image Type

C. Resolution 

D. Scan Frame 

G. Optimization 

H. Darkness

I. Density

(For MII-800XL Plus, MI-900 Plus)

(For NDT-2000)

E. Image Size
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A.	 Scan Job (Job): This shows the current scan job as indicated by the Scan Job 
Queue window and by the selected image in the Preview window.

B.	 Image Type (Type):  This shows the image type of the current scan job.

C.	 Resolution (Res) settings: This area includes the following: the Resolution 
box for specifying your output resolution; the Resolution list box (with 
the down arrow) that provides predefined resolution values for easier 
selection of the resolution setting; and the Resolution unit, which presents 
you resolution unit and the size of the dot (pixel). Your most recent scan 
resolution settings will be recorded as well.

D.	 Scan Frame options: Includes the Scan Frame settings which represent the 
dimensions of the image that you wish to scan. 

E.	 Image Size: This shows the size of the file when the image is scanned.

F.	 Unit of measurement: This lets you choose your desired unit of 
measurement, which will then be reflected in the rulers alongside the 
Preview window. Choose from inch, cm, or mm.

G.	 Optimization: This lets you reduce the random noise of the scanned image.

H.	 Darkness:  This allows you to enhance the visibility of the image by 
adjusting the exposure time for the scan through the darkness setting of the 
image. 

I.	 Density: This allows you to capture images in different levels of image 
quality by controlling the optical density (OD) of the scanner 
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Scan Job (Job)

The Scan Job box shows the currently selected scan job, which is also shown in 
the Scan Job Queue window and the Preview window.

There is always at least one scan job in existence (by default). If you have 
multiple scan jobs, not only are these reflected as multiple entries in the Scan 
Job Queue window and as multiple images in the Preview window, they will also 
be shown as multiple entries in the Job box of the Settings window.

To select from multiple scan jobs, choose the scan job you wish in the Scan Job 
box; this will automatically select the corresponding scan job in the Preview and 
Scan Job Queue windows as well. Conversely, selecting a scan job in either the 
Preview or Scan Job Queue window will automatically show that selection in the 
Scan Job box.

This means that a quick look at the Job box, the Preview Window, or the Scan 
Job Queue window can show you which is your currently selected scan job.

Correspondence between the Job box 
in the Settings window and the current 
scan job in the Preview and Scan Job 
Queue windows
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Image Type (Type)

The Image Type box shows you the image type of the current scan job. 
ScanWizard Industry allows direct scanning Grayscale color space only.

•	 Grayscale: Grayscale images use shades of gray to simulate gradations of 
color or tonal values, and contain 8 bits per pixel. 

•	 Grayscale 16-bit: Grayscale 16-bit option is provided in ScanWizard 
Industry for professional pre-press scanners.
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Resolution Settings

The settings related to resolution include the resolution box, the resolution list 
box, and the resolution unit.

Resolution is the sampling of image pixels per measurement unit or the amount 
of pixel information stored in an image. Together, the image resolution and 
dimensions determine the file size of the image, which is measured in kilobytes 
(KB) or megabytes (MB).

The resolution of an image is important in determining the quality of the 
output image. Resolution is also directly related to file size, and the higher the 
resolution, the larger the resulting file size will be.

When dealing with resolution, remember to distinguish between optical 
resolution and interpolated resolution. Optical resolution is the “real” resolution 
as measured by the scanner’s optics. Interpolated resolution is software-enhanced 
resolution and can be useful for enlarging very small images or for printing line 
art to obtain superior results.

A. Resolution box

This shows the resolution setting.  To set your resolution:

Enter a resolution setting in the Resolution edit box, then press Enter. If the 
value you enter is too high or too low, the maximum or minimum resolution 
value is entered for you instead.

Note: Not all the scanner models support 
the custom resolution. If your scanner is not 
supported (e.g., NDT-2000),  you are not 
allowed to enter any value in the resolution 
edit box.  

Depending on the type of image you have selected, a default resolution is 
displayed in the resolution box. After you enter your own resolution value, this 
value is then recorded for subsequent use, until a new value is entered and takes 
over.
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B. Resolution list box

This provides predefined resolution values for easier selection of the resolution 
setting.

To select your setting, press the up/down arrows next to the Resolution box, 
and choose your setting from the list of box.

C. Resolution unit

The unit of measurement for resolution is in ppi (pixels per inch) which is 
most commonly used as a measure of image resolution. The dot (pixel) size 
indicates how big the dot (pixel) will be when a resolution setting is given in 
the Resolution edit box, together with the resolution unit “ppi”.  For instance, 
if your image will be scanned at 200 ppi, the dot size will be 0.127 mm; and at 
300 ppi, the dot size will be 0.0847 mm.

If your scanned images are intented for on-screen display, you need not go 
higher than the target resolution of your monitor (usually 96 dpi for Windows). 
A higher resolution value will simply increase the file size of your image without 
any perceptive improvement in image quality. 

Note: The selectable predefined resolution 
settings in the list of box are vary upon the 
scanner models.  
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Predefined Scan Frame settings

Scan Frame, Image Size, and Unit of 
Measurement 

The scan farme settings affect your output image size, while a desired unit of 
measurement provides you to get the correct size of the scan frame.

A. Scan Frame settings

The Scan Frame settings (width and height) represent the area on the scan bed 
that you wish to scan.

• Specify scan frame settings

If you purchase a specific scanner model (ex. MII-900 Plus), when you activate 
the Settings window of the ScanWizard Industry,  you can choose from a list of 
predefined Scan Frame settings which are designed for the tailor-made holders 
came with your scanner. To do this, click  “Scan Frame” in the Settings window, 
and choose a value you want from the drop-down menu. You can use the 
predefined Scan Frame settings directly if you scan the film with the bundled 
holder.

If you do not want to scan the film with the holder and want to define your own 
scan frame, enter the dimensions manually in the width and height edit boxes; 
or use the Scan Frame (Frame) tool to define or resize your scan frame. Changes 
made in the Preview window are automatically displayed in the Scan Frame 
setting edit boxes.
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B. Image Size

The Image Size field indicates how big the file will be when you accept the 
dimensions shown in the edit boxes, together with the resolution setting that 
you have selected. Size is calculated automatically. The resulting file size depends 
on the image type; resolution; and dimensions of the image.

C. Unit of Measurement

The Unit of Measurement lets you select the desired unit (inch, cm, mm) for 
your image dimensions.

• Adding custom settings

The Add to Menu... allows you to save the 
setting you have made to the current scan 
job as a custom setting. You may retrieve this 
custom setting later from the Scan Frame drop-
down menu. 

To add a custom setting for a scan frame, click 
Scan Frame and choose Add to Menu ... in the 
drop-down menu. When a dialog box comes 
up, give a setting and enter the name to be 
added in the description box; then click Save in 
the dialog box. 

• Removing custom settings 

The Remove Settings... allows you to remove 
a custom setting from the list of scan frame 
settings available. 

To remove a custom setting, click Scan Frame 
to open its drop-down menu, and then choose 
Remove Settings. When a dialog box comes up, 
select the setting you want to remove, and then 
click Remove in the dialog box.

Important: Make sure you select the 
correct unit of measurement before 
entering any of the values for width or 
height in the Scan Frame Settings. 



56          ScanWizard Industry Reference Manual

Optimization

The Optimization function is a process in which the scanner samples each line 
in the image a number of times, then obtains an average to reduce random noise. 
Enabling optimization will slow down scanning, as the process requires extra 
time to yield higher-quality images.

By default, this function is hidden when activating the ScanWizard Industry 
at the first time.  To enable the function, click the View menu and then select 
"Show Optimization Btn".  You will see the Optimization Button appear in the 
Settings window immediately.

To use the Optimization function, 

1.	 In the Preview window, click the “Overview” button to preview the image.

2.	 Select the image area in the preview image where optimization will be 
applied.

3.	 In the Settings window, click 
“Optimization”, then choose an 
optimization level as you desire from its 
drop-down menu. 

4.	 Click the “Scan” button to start scanning. 
Optimization is applied, producing a 
higher-quality image.

The default Settings window does 
not show the Optimization button.
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Darkness

The Darkness function allows you to perform the exposure correction for the 
current scan job. This function tries to average the intensity of the image and to 
compensate for a very dark image, making  the dark areas of the image much 
brighter. However, a high darkness value will extend scanning processing time, 
for it requires extra time to produce a better visible image. After each darkness 
value, there comes a corresponded and suggested density value for your 
reference.

To use the Darkness function, 

1.	 In the Preview window, click the “Overview” button to preview the image.

2.	 Select the image area in the preview image where exposure will be applied. 

3.	 In the Settings window, click “Darkness”, 
then choose a predefined setting as you 
desire from its drop-down menu.   

4.	 Click the “Scan” button to start 
scanning. 

Values of the Darkness function will be 
affected by the Scan Mode in use. Also, 
when scanner models in use are different, 
these values will be modified too.
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A. Adjust Command

The Adjust...  command is an alternative way to give a darkness setting for a 
scan job. This command is enabled automatically when the ScanWizard Industry 
is started up at the first time.

To use this command,  

1.	 Click Darkness and choose Adjust... in its drop-down menu.

2.	 Point the mouse to the Darkness box. You will see an arrow appear in the 
box. 

3.	 Click and hold the arrow to adjust slider bar in order to increase/decrease 
the value of a user setting.  After you select your desired value, this value is 
then memorized for subsequent use until a new value is selected and then it 
will be taken over. 

B. Adding custom settings

The Add to Menu... allows you to save the 
setting you have chosen to the current scan 
job as a custom setting. You may retrieve this 
custom setting later from the Darkness drop-
down menu. The darkness adjustments are 
made from 0 to 10 in 1 up increment.

To add a custom setting for darkness, click 
Darkness and choose Add to Menu ... in the 
drop-down menu. When a dialog box comes 
up, give a setting from the range (0-10) and 
enter the name to be added in the description 
box; then click Save in the dialog box. 
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C. Removing custom settings 

The Remove Settings... allows you to remove 
a custom setting from the list of darkness 
settings available. 

To remove a custom setting, click Darkness to 
open its drop-down menu, and then choose 
Remove Settings. When a dialog box comes 
up, select the setting you want to remove, and 
then click Remove in the dialog box.

E. Restoring default setting

The Default command restores exposure setting back to the default value offered 
by the ScanWizard Industry software. The default value is 0. 

To restore the default exposure setting, click Default in the Darkness drop-down 
menu. 

D. Loading / retrieving custom Darkness settings

To load or retrieve a custom setting that you have previously defined, click 
Darkness to open its drop-down menu, and then choose a setting you wish to be 
loaded.



60          ScanWizard Industry Reference Manual

Density

The Density function allows you to capture images with different image quality 
by changing the value of optical density (OD) of the scanner. Optical density 
refers to the range of gradation of the image that can be captured by the scanner. 
It is generally expressed by letter “D”. The larger value of the optical density you 
select, the higher image quality you can get. 

Depending on various requirements for image quality, you have the following 
options:

• 	 3.5D: It allows users to get an image with OD quality between 0.5D and 3.5D. 
Image processing is delivered faster.

•	 4.0D: It allows users to get an image with OD quality between 0.5D and 4.0D. 
Image processing is delivered a little slower but in high quality.

• 	 4.5D: It allows users to get an image with OD quality between 0.5D and 4.5D. 
Image processing is delivered slow but in best quality.  

Based on the needs/image quality requirements of the film inspection, select an  
appropriate level of the image quality from the Density drop-menu. If you need  
high-quality image for an analysis, please select 4.5D; however, it will increase 
the time of scanning and image processing without any doubts. 
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The Scan Job Queue Window

The Scan Job Queue window provides several functions for managing your scan 
jobs. By definition, a scan job contains the following elements: a set of scanning 
parameters (shown in the Settings window); a scan frame (shown in the Preview 
window); and one or several scan job items (shown in the Scan Job Queue 
window).

You can have multiple scan jobs, each having its own distinct settings. Scan jobs 
marked with a check are the ones designated to be scanned, and the jobs are 
scanned in the order that they appear in the Scan Job Queue window.

The Scan Job Queue window works only for the scanners that support multi-
film scanning (ex. MII-800XL Plus). If the scanner model you purchased is not 
supplied with the Scan Job Queue window, ignore the introduction of the whole 
section about the Scan Job Queue Window.

Note: If the Scan Job Queue window is closed, go to the View menu in the Preview 
window, and choose the Show Scan Job Queue window command. Also take note that 
not all the scanner models support this window If your scanner is not supported (e.g., 
NDT-2000), the Scan Job Queue window will not be shown in the Windows desktop. 

B. Checked  
Scan Job

Elements of the Scan Job Queue Window  
(For MII-800XL Plus)

C. Image type  
display

F. Title of scan Job

H. Image size

D. Function buttons for controlling the scan jobs  
(i.e. Up/Down arrow, Duplicate, New, Delete, Check, and Load/Save) 

E. Thumbnail of  
    Prescan image 

G. Selected Scan Job  
   (highlighted)

A. Current  
Scan Job 
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A	 Current scan job: This is the current scan job, indicated by a frame around 
the title. There may be several defined scan jobs, but only one scan job can 
be current. In the Preview window, the current scan job is the one with the 
flashing marquee.

B.	 Checked scan job: Checked scan jobs are the ones that are scanned when 
you click the Scan button in the Preview window. The check box is a toggle 
for checking / unchecking a scan job. To check a box, you can either click 
the check box or use the Check button at the bottom of the Scan Job Queue 
window.

C.	 Image type display: This shows the image type of the scan job .

D.	 Function buttons for controlling scan jobs: These buttons perform a specific 
action on the selected scan job. The Duplicate, New, Delete, Check and 
Load/Save buttons can be used on multiple selected scan jobs.

E.	 Thumbnail of prescan image: A thumbnail appears for the selected scan 
job after you click the Prescan button in the Preview window. This means 
a prescan image is available for that scan job. To see the prescan image, 
double-click the scan frame or go to the View menu in the Preview window 
and switch to prescan image viewing mode.

F.	 Title of scan job: The title of each scan job is shown. To edit a scan job title, 
double-click the title and type a new name when an edit box appears.

G.	 Selected scan job: The selected scan job is the highlighted item. You can 
have multiple selected scan jobs, and clicking on a function button (such as 
Check or Duplicate) will implement that function on the selected scan job.

H.	 Image size: This is the image size of the scan job.
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Selecting Multiple Scan Jobs

The Duplicate, Delete, and Check buttons at the bottom of the Scan Job Queue 
window can be used for multiple job selections.

For example, you can select multiple scan jobs, and then click the Delete button 
to remove all the jobs simultaneously.

To select multiple scan jobs, press the Ctrl or Shift key and click on the jobs to 
be selected. 

Editing Multiple Scan Jobs 

ScanWizard Industry lets you edit multiple scan jobs at the same time, increasing 
your efficiency in using the software.

To edit multiple scan jobs, simply select all the scan jobs to be edited in the Scan 
Job Queue window. To include each scan job for selection, use the Shift + Click 
combination (pressing the Shift key while clicking the mouse at the same time). 
Then perform the selected editing function.

For instance, you can go to the Settings window and choose an image type that 
will apply to all the scan jobs. Another example is to apply a common resolution 
setting to all the scan jobs. Simultaneous editing simplifies the scanning process 
for you.
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Adding a New Scan Job

The New button lets you create a new scan job; the new scan job will have 
default settings. This feature allows you to create as many scan jobs as you wish, 
and each scan job can then have its own settings.

1.	 Click the New button.

2.	 When a title of new scan job appears, accept the default name or enter 
a name for the new scan job. Use unique names for your scan jobs, as 
duplicate names are not accepted.

3.	 Define the scan frame in the Preview window for the new scan job.

4.	 In the Settings window, specify the settings for the new scan job. With the 
creation of a new scan job, the new scan job becomes the current scan job.

Duplicating a Scan Job

The Duplicate button lets you duplicate the settings of a scan job. This function 
is very helpful if you have created optimal settings for a scan job and wish to 
use these settings as a template for other scan jobs. This saves time, as you don’t 
have to create the settings repeatedly for every scan job you make.

1.	 From the list of scan jobs available, select the scan job(s) to be duplicated.

2.	 Click the Duplicate button. The selected scan job(s) will be duplicated. The 
Duplicate function is very useful when scanning several images at the same 
settings.

Removing a Scan Job

The Delete button allows you to remove a scan job from the list of scan jobs 
available. 

To delete a scan job, highlight the scan job to be removed, then click the Delete 
button.
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Checking a Scan Job

The Check button allows you to select the scan jobs to be scanned. Checked 
scan jobs are the ones that are scanned when you click the Scan button in the 
Preview window. The check button is a toggle for checking / unchecking a scan 
job. 

To check a scan job, highlight the scan job, then click the Check button. A check 
sign will appear next to the selected scan job.

To uncheck a scan job, highlight the scan job, then click the Check button. The 
scan job will be unchecked, and the scan job will not be scanned when you click 
on the Scan button.

The Up/Down Arrows

The Up/Down arrows allow you to change the order of the scan jobs in the Scan 
Job Queue window.  

To move up/down the scan job, highlight the scan job, then click the Up/Down 
arrow to change the order of the scan job in the list. 

When you start scanning, the scan jobs will be processed and scanned in the 
order that they appear in the Scan Job Queue window.
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The Load/Save button

The Job Template Manager lets you save current scan job as a template which 
can be loaded when necessary. Also, it allows you to delete scan jobs easily from 
folders.

To save a scan job as a template into a selected folder:

1.	 Click on the Load/Save button to open the Job Template Manager window.

	

2.	 Click the Folder icon (yellow) or use the current default folder to select the 
folder for saving scan jobs.     

3.	 Highlight the scan jobs to be saved at the right column of the window.

4.	 Click the <<Save button. The selected scan jobs will be saved and appeared 
at the left column of the window.  

	

	 You may also specify different folders for respective scan job templates as 
you desired.
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To load a scan job to the Scan Job Queue, 

1.	 Click the Load/Save button to open the Job Template Manager window.. 

2.	 Switch to the folder where the scan job is stored.  

3.	 Highlight the scan job to be loaded at the left column of the window. 

	 Before loading a new scan job, you may remove your existing scan jobs from 
the right column 

4.	 Click the Add>> button to load the scan jobs from a selected folder to the 
Scan Job Queue. 

To remove a scan job from the Scan Job Queue,

1. 	 Click the Load/Save button to open the Job Template Manager window.. 

2.	 Highlight the scan job to be removed at the right column of the window.

3.	 Click the Remove or Remove all button to remove the scan job from  the 
Scan Job Queue. 

New name auto given if the name already exists

When you load or save scan jobs, you may check or uncheck the “New name 
auto given if the name already exists” option. Suppose the scan jobs already 
exist, if you check this check box, the number suffix is automatically appended 
as a new scan job. If unchecked, the existing scan jobs are overwritten.



68          ScanWizard Industry Reference Manual

Appendix 

Product and Technical Support

If you need to call Technical Support, please have the following information 
ready:

•	 Your scanner model. The model name is indicated on the front of the 
scanner, not the back. 

•	 The scanner's serial number. This can be found on the back of the scanner.

•	 Your computer name and model

•	 The version number of ScanWizard Industry. This is indicated on the 
ScanWizard Industry scanning software.

•	 Your system components, or the devices on your system, such as an external 
hard drive, CD-ROM, etc.

•	 Software being used with your scanner.


